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Update Information
Return to this page on-line at www.altiris.com  to learn about the latest changes to LabExpert and this docum
tion. Information about both are updated whenever changes are made.

Executive Summary
As a resource manager for computer classrooms or labs, much of your time is spent installing software, string
cables and manually resetting computers, etc.

As the industry's premier networked computer automation software, LabExpert provides managers of networ
computers with outstanding control over their resources. LabExpert lets you manage your computers from a s
node on the network. From any computer, you can be in control.

LabExpert helps you control costs as well. Companies invest large sums of money to develop labs and classr
testing and training, yet fail to manage on-going expenses contributing to the bill. IS personnel for instance—
much of their time completing redundant tasks. 

LabExpert not only reduces overall administrative costs, it allows you to devote your time and energy to real 
lenges. For example, LabExpert helps you optimize your efficiency and accuracy, which allows more time for 
test analysis and program planning.

What LabExpert can do for you
• Easily store and restore images 

• Quick turnaround of test environments

• Fast change-over of classroom resources

• Quick and easy cleanup of PCs in student labs

• Fast restore of corrupt PCs in classroom or student lab

• Fast installation and configuration of Windows 95/98 and NT

Overview
LabExpert is a flexible suite of six closely integrated automation tools and technologies as shown in Table 1. 

Table 1: LabExpert Suite Components

BootWorks® A virtual boot ROM governing the boot 
sequence of the computer.

LabExpert Control Console 
(LCC)

The central point of control for managing the 
entire automation process.

ImageBlaster Agent™ A disk imaging technology providing rapid 
duplication of software to networked 
resources.

SIDgen™ A security attribute modification utility for 
Windows NT that regenerates SIDs for NT 
Workstations and Servers (standalone, PDC 
and BDC).

Registry Management Tools that help manage the registry files in 
Windows 95/98/NT

Remote Control Agents Software agents residing on each computer 
allowing you to cause a remote reboot fro
the control console.
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LabExpert Basic Model
The LabExpert basic configuration model is shown in Figure 1. It consists of a server, control console and an
ber of computers. The server can be any type of server providing file-sharing capabilities, such as a dedicate
print server or a peer-to-peer workstation to which the networked computers can establish a connection.

Figure 1: LabExpert Basic Model

The Lab Control Server (LCS) contains the BootWorks control database as well as any disk images, registry 
other files needed to individually configure the computers.

The LabExpert Control Console (LCC) is a Windows 95/98/NT workstation or Windows NT server from which
LabExpert Control Console is executed. This can be your console (or any PC) from which the automation pro
managed.

The computers can be any type of Intel-based PCs having a network connection to the LCS. The BootWorks 
executed on each computer. 

Note: Figure 1 shows all components on the same network. The LCS, LCC and the networked computers ca
any network as long as the computers and console can establish a connection to the server. You can, of cour
the same computer under Windows for the LCS/LCC.

BootWorks
One major problem in configuring several computers with new software is getting the computers into a state w
the desired software can be installed. For example, to install Windows 95/98 onto computers that previously h
UNIX-based operating system, boot each computer from a “bootable” floppy, load the necessary LAN drivers
client software to gain access to a central server and install Windows 95/98 from the central server. This proc
requires you to go to each computer, boot it and type the proper instructions on the keyboard everytime you w
make a change. 

Process Builder A utility that instantly configures all required 
batch files for basic image management (task 
chaining, console scripting, etc.).

Table 1: LabExpert Suite Components
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To alleviate the need for operator input at each computer, LabExpert provides BootWorks, Altiris’ patented te
ogy. When BootWorks is installed on a workstation's hard drive, it controls the boot sequence of the compute
ing as a 'virtual floppy'. When some sort of automation work is to be performed on the computer, BootWorks 
the computer to “boot” from the virtual floppy. BootWorks examines the LabExpert Control Database residing 
server, determines the type of automation work to be performed, then initiates the desired work. When no au
work is intended, BootWorks causes the computer to “boot” normally into the “production” operating sy s t e

In this way, you set up the necessary automation work through the LCC and let BootWorks start the work on 
computer .BootWorks can be executed from a bootable floppy or it can be installed on a computer's hard drive
as a virtual boot ROM. 

Installing BootWorks on a computer's hard drive alleviates the need to use a floppy disk to get the computer t
form some type of automation wor k. When the computer is running the “production” operating system, BootWork
is NOT in memory nor visible on the hard drive; therefore, it does not interfere with the “production” operating
tem.

The Control Console
The console is the central point of control for LabExpert. It's a GUI-based application from which you control t
automation process for the networked computers. It presents the computers to you as icons, allowing you to 
edit DOS batch and script files to be “assigned” to the computers. It provides a mechanism whereby the comp
can be booted remotely when needed. The information used and manipulated by the LCC is contained in the
database on the LCS. 

The process of “assigning” a DOS batch file to a computer is as simple as dragging a batch file to the compu
icon. It’s like putting the batch file on the virtual floppy for that computer. The next time the computer boots an
BootWorks, it executes the “assigned” DOS batch file. Since the computer is running DOS while in the autom
mode, any valid DOS command or program can be executed in the DOS batch file. 

This process makes it easy to launch the ImageBlaster Agent imaging tools.

ImageBlaster Agent
ImageBlaster Agent consists of four utilities: IBMASTER, IBSLAVE, NWPREP, and SIDgen. These tools allow
located on one computer to be replicated (or imaged) to other computers independent of drive geometry. 

IBMASTER is a DOS-based program used to create images (upload the contents of a hard drive to an image
server) or restore images (download the contents of an image file located on a server and placing it on anoth
puter’s hard drive). This tool can image the contents of an entire hard drive or it can image only selected parons. 
Also, the content of the hard drive is unimportant. ImageBlaster Agent works on FAT partitions as well as NTF
2 HPFS, NetWare and Unix partitions.

ImageBlaster Agent can also replicate the contents of one computer to any number of other computers simult
without creating or reading data from an image file (see Figure 2). This is referred to as “peer-to-peer” imagin
IBMASTER multicasts the drive data onto the wire once and all computers running IBSLAVE pick up the data
write it to their own drives.
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Figure 2: ImageBlaster Agent Peer-to-Peer Model 

Imaging tools from other companies require the image data be located in an image file on a server and each 
receiving the image read the data from that file. This means more data is sent across the network as more co
are imaged with the same image. This not only creates more network traffic, it also slows the entire process (
exponentially). Since ImageBlaster Agent uses a multicast mechanism, the time required to image 1000 com
the same amount of time required to image two or three. 

ImageBlaster Agent can also use a combination of the above methods. It can create an image file on the ser
it multicasts the data to the slave computers or it can restore an image from an image file stored on a server 
ticast that image to the slave computers. 

Disk imaging is a fast and convenient way to distribute the same software to many computers ensuring all co
are configured identically. Libraries of images can be created so reconstruction of a networked environment c
accomplished by downloading the original images to the computers—thus ensuring each computer is configu
exactly as it was originally.

Registry Management
One of the great features of disk imaging is all computers are configured with EXACTLY the same software, 
OS, same drivers, same utilities, etc. One of the drawbacks of disk imaging is all computers receive EXACTL
same configuration settings. 

This presents a problem for products such as Windows 95/98/NT that keep both hardware and software conf
information in their “registries.” The registry for one computer may not be what is needed on another compute
changes in hardware as well as software or environment changes.

To overcome this problem, LabExpert provides a set of registry tools. The first set of tools allows you to “archi
registry files for the computers, store them on the LCS and restore them after subsequent imaging. 

For example, an image might contain Windows 95/98 along with specific tools and applications. This image c
replicated to all of the networked computers after which Windows 95/98 is allowed to “discover” any differenc
hardware and update the registry accordingly. Customizations such as computer name, workgroup, IP addre
can be made to each computer. 

When all the computers are configured as desired, their registry files can be archived with the registry manag
and stored on the LCS. This “registry archiving” procedure is performed only once when the image is first cre
 1998, 1999 Altiris, Inc. page 5 of 40
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From this point forward, the exact configuration can be recreated by first distributing the image to all compute
then restoring the archived registries from the LCS. 

The second registry tool allows you to create one database file (text file) containing the specific registry keys 
ues to be changed on each computer and have a .reg file created on each computer containing only the valu
particular computer. The .reg file can be imported into the computer’s registry.

By combining the Registry Mangement tools with use of the Remote Control Agents, you have complete cont
every computer, whenever you want.

The Remote Control Agents
The Remote Control Agents are services or programs executed on each computer able to receive command
tions from the LCC. When you want a computer to reboot or execute a particular command, a command instr
sent from the control console to the designated computer. The agent on the computer receives the command
cutes the command or reboots the computer. The following agents are currently available: 

• DOS agent

• Windows 95/98 service

• Windows NT service

These services are configured and installed when you use the Client Install diskette.

Process Builder
Many setup and configuration tasks for computers require several events. For example, to restore a Window
computer from an image file, complete with its original registry files, requires multiple steps. As an overview o
what’s required:

• An image is be restored to the computer using the ImageBlaster Agent. 

• The computer is rebooted so the new data on the hard drive can be read by the operating system. 

• The registry files are restored via the registry manager. 

• The computer is rebooted again to boot the newly installed/re-installed Windows 95/98, complete with th
registry data. 

This process can be completed manually or automatically. Because the management work performed via the
pert Control Console (LCC) is immediate and singular, meaning it happens immediately and one thing at a tim
can manually input each command at the LCC to start each event. From the LCC you can:

• Assign a batch file to the computer that launches and performs the image process. 

• Send a reboot command from the console to force the computer to reboot and execute the assigned ba

• Assign a second batch file that runs the registry manager to restore the registry files. 

• Send a second reboot command from the console to force the computer to reboot and execute the assig
file. 

• Mark the computer to boot to its production partition.

• Send another reboot command to make the computer boot to the new Windows 95/98. 

As you can see, this is not necessarily a complex process, but one that requires manual input at several diffe
points in the process. 

Or, you can “chain” these events to each other so each step follows the previous step without your input with
additional utilities. 

LABCMD and NEXTSTEP
LabExpert provides two utilities to make command chaining possible: the console scripting tool LABCMD and
NextStep command. Using LABCMD, construct one batch file to automatically execute a second batch file w
first completes and forces the computer to reboot. The second batch file uses NextStep to mark the compute
to its production partition and forces the reboot when complete. 

In this chaining scenario, you use the LCC to assign the first batch file and, with LABCMD and NextStep, you
the computer and walk away. All the events are performed in sequence without further intervention.
 1998, 1999 Altiris, Inc. page 6 of 40
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LabExpert Quick Start Guide
Welcome to Altiris LabExpert! If you require more information beyond the scope of this Quick Start guide, see
details in the Configuration and How Do I? sections of the on-line manual. Once you have installed LabExpe
can perform any of the following tasks instantly:

• Save and restore images at will, manually or unattended

• Reboot and control every networked computer from a single PC (your Control Console)

• Upload each client’s registry files individually

• Upload new registries anytime without creating entirely new images

• Download registries (separate from the entire image) one at a time or in groups whenever necessary

LabExpert Components
LabExpert includes the use of a Lab Control Server (LCS), 
a LabExpert Control Console (LCC), and client computers
(When using Windows 95/98/NT, the LCS and the LCC 
can be the same computer.) This Quick Start Guide illus-
trates the use of LabExpert using only two client computers 
plus a server and a Control Console. Each client should be 
designated as either:

• An image source computer (a computer already 
loaded with Windows, etc.) 

• An image recipient computer (any other computer)

Before You Proceed
These instructions assume the following:

• You have already downloaded the LabExpert Suite onto a network server (either a dedicated server or a
server device) but not installed the suite, or you are installing from a distribution CD-ROM.

• You have a computer already configured with an operating system, applications and files you want to ima

Note: If you don’t have a computer ready to image, see Create a Base Image Computer in the on-line m

Install LabExpert 
1. From the Windows 95/98/NT client that you want to become the LabExpert Control Console (LCC), login

administrator to the server to which LabExpert has been downloaded. 

2. From the LCC, run the LabExpert setup utility LE_SETUP.EXE.

Accept the recommended server directory name LABEXPRT (for example: F:\LABEXPRT where F:\ is th
drive mapping to the LabExpert server.

Note: Notice the missing “E” in the directory name.

3. Enter the License key information acquired from your reseller or from Altiris. The licensee and key are bo
case and space sensitive. 

Create a BootWorks User 
1. Use the appropriate network administration utility to create a user called “bootwork” with no password.

2. Grant “bootwork” sufficient rights to create, open, read and write to the \LABEXPRT directory. 

For a Windows server: 

a. Make the LABEXPRT folder a shared folder (a Share point).

For NetWare networks only:

a. Configure the “bootwork” user to automatically set a search path to the \LABEXPRT\BIN directory. 
b. Make \LABEXPRT\DATA the current working directory for the “bootwork” user. 
 1998, 1999 Altiris, Inc. page 7 of 40
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Create BootWorks Diskettes
BootWorks lets you reboot all client computers from the LCC. You can also specify which commands each co
processes as it boots. You must first install BootWorks on each client PC with a BootWorks Install diskette.

Use the Boot Disk Wizard to create three diskettes: 

• Two “Install” diskettes

• One “Boot” diskette

Create the Install Diskettes
Two Install diskettes are required to install the BootWorks Partition on two client computers. The BootWorks P
tion (also called the Automation Partition) lets LabExpert remotely image and configure the client computers.

Note: You can use either IP or IPX protocol. If using IPX, one Install diskette works on multiple clients, so you
would only need to make one Install diskette.

To create the Install diskettes, 

1. Make sure the LCC client has Internet access to retrieve the necessary drivers.

2. Select Start > Programs > Altiris LabExpert > Boot Disk Wizard

3. Select the appropriate DOS for the clients.

4. Select the server type.

5. Select the protocol.

6. Select and configure the appropriate NIC type.

7. Using the directions provided in the information frame of the Server Authentication window, set your network 
drive mapping.

8. Select the LabExpert Install application type. 

9. Accept the default partition size of 4 MB when building an Install  diskette.

10. Set the duplication count to two (2) and change computer name when prompted for the second diskette

Create the Boot Diskette
You need to create one Boot diskette to boot and connect a client to the server and map the required drives 
LabExpert directories. 

1. Repeat steps 1 through 8 above, substituting LabExpert Boot  for the application type in step 8. See the Boot
Disk Wizard documentation in the on-line manual for more information.

Create Batch Files 
Altiris provides the LabExpert Process Builder to automatically create a series of batch files simplifying the im
file configuration process. The following exercise uses two client computers: one as a Master computer, the o
Slave (it doesn’t matter which client is the Master or Slave). 

To create batch files,

1. Choose Start > Programs > Altiris LabExpert > LabExpert Control Console.

The “Getting Started” help system is displayed. You can follow these abbreviated steps anytime you nee
reminder of what to do and how to do it. For now, close the Getting Started window and continue with ste

2. Run the LabExpert Process Builder by opening Tools > LabExpert Process Builder.

3. Fill in all applicable fields by following the prompts in the right portion of the window. 

4. Make note of the category and image descriptor you specify to contain the batch files. These names def
directory structure and image file name used and displayed in the LCC. For example: 

A <category> of training  and an <image descriptor> of win95 results in the creation of two folders and an 
image filename. The actual structure created from the example above looks like this:

\LABEXPRT\DATA\TRAINING\WIN95\WIN95.IMG
5. Set the number of Slave computers to 1 (one).
 1998, 1999 Altiris, Inc. page 8 of 40
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6. In the lower right corner, select Automation Partition  for this build.

7. After providing the required information, click Build . 

The Process Builder instantly creates the required batch files according to the selections you make.

8. Click Exit .

9. To verify creation of the batch files you just created, at the LabExpert Control Console, click the plus sign+) 
next to Batch Files, <Category>, and <Image Descriptor>. The batch files should appear.

10. Write down the names of the <Category> and <Image Descriptor> you created. These names are used again
step 13 of the Create the Image File section.

Create the Image File
Now you are ready to create an image file. The image must include LabExpert’s Remote Control agents. The
Install Wizard creates a diskette with the necessary files.

Warning: Before creating an image for a computer running Windows NT, modify your c:\boot.ini file so all 
references to Partition (1) are changed to Partition (2). See IBMIGRAT.EXE in the online documentation.

1. Obtain a blank, formatted diskette.

2. At the LCC computer, choose Start > Programs > Altiris Client Install > Make Client Diskette 

The diskette is created with the appropriate files.

3. Insert the new Client Diskette into the image source computer (it should currently be up and running Win
and run A:\SETUP.EXE. 

4. Select Remote Control for LabExpert and click Next, Next, Finish.

5. Boot the image source computer with the LabExpert Boot Diskette you created earlier in the Create Booorks 
Diskettes section. This establishes a temporary connection with the server. 

6. (Windows NT only) When asked to create a password file, press Enter, type Y and press Enter. Without typing 
anything more, press Enter again. The process stops at a NONE FOUND message. 

7. When prompted for the computer’s object name, enter a unique name used to identify this computer at t

8. The BootWorks (Automation) Partition must reside in the first partition on a hard drive. You are going to m
your current partition using the LabExpert utility IBMIGRAT.EXE.

9. At the F:\DATA prompt, run IBMIGRAT.EXE.

10. Type S to Slide the partition. Your existing partition is redefined to reside in Partition 2. IBMASTER.EXE s
automatically.

11. Select Upload to image file.

IBMaster displays the partition as if it were installed on partition 2.

12. Select Partition 2 by pressing the Space Bar and Enter.

13. Type an image file name to fit the following pattern:

.\<CATEGORY>\<IMAGE DESCRIPTOR>\<IMAGE DESCRIPTOR>.IMG

replacing the <category> and <image descriptor> with the same values recorded from step 10 in the Create 
Batch Files section. For example: .\TRAINING\WIN95\WIN95.IMG

14. Select Start.

An image is created of your Windows partition. The image is saved in the 

F:\LABEXPRT\DATA\<category>\<image descriptor> directory and is called <image descriptor.img>.

15. While your image is uploading, complete the Install BootWorks section for the image recipient computer. 
When you return to this PC after the upload is complete, choose L  to leave the partition in its shifted state.

Check Poin : When complete, the image file is stored on the server, ready to download to the client computer

Install BootWorks
While the base image computer (the first client) is uploading the image, install BootWorks on the second clien

1. Use one of the BootWorks install diskettes to boot the second client (the image recipient computer).
 1998, 1999 Altiris, Inc. page 9 of 40
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2. If a partition is found on this computer, you are prompted for a decision. Since you are currently saving th
tition you want to use from the other client, and will download it to this client PC later, select E to erase this 
partition and follow the on-screen instructions

3. When the Automation Partition installation is complete, the computer is left at the A:\ prompt. Remove th
kette and reboot the computer.

4. As the computer reboots: 

a. NetWare logs you in without additional steps
b. Windows NT requires you to press Enter to accept “bootwork” as the user login name and press En

again. When asked to create a password file, type Y and press Enter. Without entering anything more, 
press Enter again.

5. When prompted for the computer’s object name, enter a unique name used to identify this computer at LCC. 

6. Using the second install diskette, repeat steps 1 (erasing the existing partition) through 4 on the image s
computer, once it has completed its upload procedure. The second “install” diskette is used so this comp
receives a unique IP address and computer name (if using IP).

Step 5 is not repeated because this computer already has an object name (computer name) in the LCC 
so you are not prompted for the object name again.

Important : This computer stops at a BootOrg or non-system disk message. This is correct. Continue with th
Test the Installation section.

Test the Installation 
Test your installation by following these steps:

1. From the LCC, verify that the client computers are displayed in the console’s list view. Click the All Comput-
ers icon in the left half of the LabExpert console screen. 

You should see a computer icon for each computer configured with BootWorks. You can press F5 anytime to 
refresh the display.

2. Create a group at the console.

a. Right click the Groups icon.
b. Select New > Group and enter a name.
c. Click the Groups icon to see the Groups.
d. Click the All Computers icon to see the computers in the group.

3. Drag and drop the icons for the client computers to the new group.

4. Choose View > Options, check Boot to Automation Upon Batch Assignment, and click OK (you can remove 
this check mark whenever you want to force a normal reboot, even when a batch assignment exists.)

5. Assign your new group to the KEYTEST.BAT file: 

a. Click the (+) next to the Batch Files icon.
b. Click the (+) next to the Samples folder.
c. Drag the new group’s icon to KEYTEST.BAT. The batch file name is displayed next to each compute

to which it has been assigned.
6. Manually reboot both client computers.

7. Verify that the client computer screens display LabExpert Now Functional message. 

8. At the LCC, press F5 and verify the status field as Functional test complete. 

If the computer icons aren’t displayed in the right window, click the All Computers item in the top left win

Check Poin : LabExpert is installed, the image saved and the client computers are ready to receive the image

Multicast the Image File
During a multicast, one target computer is designated as a Master to first receive the image, decompress and
the image to all other target (slave) computers. This methodology reduces the load on the server and require
image to cross the wire only twice instead of once for each target, even if you are imaging 2000 computers.
 1998, 1999 Altiris, Inc. page 10 of 40
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1. At the LCC, drag the group you created earlier to SLAVE.BAT (in the <image descriptor> directory specified 
earlier for the batch files creation). 

2. Drag one computer icon to MASTER.BAT (in the same directory) overriding the slave assignment made
1 (it doesn’t matter which computer you use as Master or Slave).

3. Right click the group and select Reboot. (If you selected IPX while creating the boot diskettes, open View >
Options > Remote Control and select IPX/SPX in the Communications Protocol box.) 

The two client computers reboot, come up in Automation Mode and receive the image. After automatica
rebooting again and, if the image is a Windows 95/98/NT image, the computers try to download registrie
Because the registries have not been uploaded yet, an error message is displayed stating the registries
found. Do NOT press Esc.

4. After receiving the error, mark the computers to boot to Production Mode through the LCC (right-click the 
group and select Boot to > Production).

5. Reboot both client computers.

The computers boot to Production Mode. If the image is using Windows 95/98/NT, an error message ap
because both computers received the same registry files.

6. Click OK. The normal process of trying to auto-detect hardware might delay boot completion. This mean
might need to wait a few minutes to ensure the computers have completed all necessary auto-detection
ware before continuing. 

Upload Registry Files
1. When auto-detection is complete, physically go to each computer and ensure that all Computer Names 

Addresses are set to unique values. Allow the computers to restart as prompted by Windows.

2. At the LCC, drag your group to REGUP.BAT in your batch file directory and reboot both client computers

When the computers reboot, they upload (back up) their registries, then reboot again to Production Mod

Check Point: The necessary Registries have been backed up. You now have the three required components:
image file, 2) the individual registries and 3) the batch files necessary to place this Image Configuration on on
more computers. 

Test the Complete Solution
1. At the LCC, drag one client computer icon to SLAVE.BAT. 

2. Drag the other client computer icon to MASTER.BAT. 

3. Reboot both client computers.

The computer screens display each client’s progress.

Check Point: The computers all receive the same image, then reboot and receive their own backed up registr
finally reboot again to production mode, each with their own Computer Name, IP address and any other setti
were stored in the registries. 

Important:  The REGUP.BAT and REGDOWN.BAT files are two very powerful tools that make the automatic r
ration of registries possible. Once the registries are established, you don’t need to visit each client every time
multicast an image. From then on, the correct registry files are automatically downloaded to the appropriate c
whenever they receive this image. You can even download just the registries anytime you want. Learn about
potential of these tools in the How Do I? section of the on-line manual.

By repeating the procedures above, you can set up any computer or group of computers for control by LabEx
Once you’ve taken a computer all the way through the Upload Registry Files process, you don’t need to phys
visit that computer again. You can reboot, re-image, and reconfigure a computer from the LCC. For informatio
about all Altiris products, see our Web pages at www.altiris.com.
 1998, 1999 Altiris, Inc. page 11 of 40
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C. 
Install LabExpert

System Requirements
Listed below are the basic hardware and software requirements for installing LabExpert: 

Network Server 
• Any dedicated server or peer-to-peer device allowing connection between itself and the clients

• Any network adapter with a DOS-based driver

• IP or IPX protocol stack

• 10 MB free disk space for LabExpert program files 

• Additional disk space if storing workstation image files 

Note: From here on, the network server is referred to as the LabExpert Control Server (LCS) or the server tha
the LabExpert program files and images. 

LabExpert Control Console (LCC)
• Computer running Windows 95/98/NT (3.51 or above) 

• 16 MB RAM 

• Network connection to LCS 

• IP or IPX Protocol Stack 

Networked Computers 
• Network adapter with connectivity to LCS 

• IP or IPX protocol stack

Prerequisites
• Complete the hardware installation of your network configuration including computers, network adapters

cables, hubs, etc.

• Determine the computer to be used as the LabExpert Control Console (LCC). Because the installation o
LabExpert creates icons and makes registry entries, you need to install LabExpert from the computer yo
later use as the LCC.

Overview
All components of LabExpert are designed to be used either on the LabExpert Control Console (LCC ) or the client 
computers. To ensure access to all components from any networked computer, they are stored on the Lab C
Server (LCS). 

Accept the default directory \LABEXPRT on the LCS during installation and the components are installed in th
following sub-directories. 

Note: Please see the Update Information page (on line) and the README.TXT file for the latest information o
changes, installation issues and known problems.

Setup 
The setup utility, LE_SETUP.EXE completes these four tasks:

• creates a “home” directory for LabExpert

• extracts the proper files for distribution and places them in a specific directory structure off the “home” d
tory

• applies your license key information to the proper utilities

• creates several icons on your desktop to access the LCC and the various documents

Since the setup utility creates icons on the desktop, run LE_SETUP.EXE from the computer acting as the LC
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The setup utility can be found in the root directory of the LabExpert distribution media or the directory to whic
copied the LabExpert package from the net (www.altiris.com). 

During installation, you are prompted for a destination directory for the program files. Enter a path to a directo
the LCS. If this path doesn’t exist, the setup utility creates it. 

Note: We recommend you install LabExpert into a directory called LABEXPRT (i.e. F:\LABEXPRT where F:\ i
drive mapping to the LCS). The examples and discussions in this manual assume the product was installed i
\LABEXPRT directory.

Also during the installation, you are prompted to enter the License key information. This information can be o
from either the letter accompanying the product or an Email from Altiris. 

The license key information is case sensitive as well as space sensitive. You must enter it exactly as written. 
setup utility doesn’t allow you to progress further until a valid key has been entered.

Directory Structure 
The setup utility creates a “home” directory for LabExpert, extracts the proper files from the distribution media
places them in a specific directory structure as illustrated below. 

\LABEXPRT

|___ DATA 

|_ SAMPLES

|_ TEMPLATES

|___ BIN

|___ DOCS

|___ BOOTWOR

|___ TECHSUP

Table 2: Product Directory Structure

DATA Contains the LCC along with the computer resource 
database files. This should be the current working 
directory for the LCC. This should also be the home 
directory for the BootWorks clients.

SAMPLES Contains sample batch files to test the installation and 
provide you with examples.

TEMPLATES Contains template batch files that perform most basic 
setup tasks for computer configurations. These tem-
plates can be the starting point for new computer con-
figurations.

BIN Contains most of the tools except for the LCC. This 
directory should be in the BootWorks' path during 
automation mode.

DOCS Contains the LabExpert manuals. These manuals are in 
HTML format and can be viewed with any Web 
browser at www.altiris.com.

BOOTWORK Contains the BootWorks workstation distribution and 
setup files.

TECHSUP Contains several debug tools. These tools are used in 
conjunction with Altiris' technical support staff in 
troubleshooting problems.
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Licensing Altiris Applications 
The setup utility applies the license key to the proper utilities during installation. However, this only applies to
files contained in the initial distribution. From time to time, you may receive updated tools via Email or the Alt
web site. Before they can be used they must be licensed. 

A license utility (LICENSE.EXE ) is included with LabExpert in the \LABEXPRT\BI  directory. Use this tool to 
apply your license to executables you receive from patches or upgrades. 

You should have received your license information via E-mail, FAX, letter or license file on the distribution me
depending on how you purchased (or obtained for evaluation) the product. You need this information/file as yo
the LICENSE.EXE  utility to license the following files

The additional utilities in LabExpert are licensed as a part of the suite installation. 

Licenses are additive. This means you can increase the number of nodes supported by LabExpert by purchas
additional license with more nodes and applying the new license to the necessary utilities. For example, if yo
IBMASTER is licensed for 50 nodes and you need 75 nodes, you can purchase a license for an additional 25
and apply the license to IBMASTER thus increasing its license to 75 nodes. 

License Utility 
The license utility (LICENSE.EXE) is Windows-based, see Figure 3. 

Figure 3: License utility 

Table 3: Tools to be Licensed

Tool Description Executable Pathname

Imaging tool LABEXPRT\BIN\IBMASTER.EXE

Control Console LABEXPRT\DATA\LABEXP.EXE

Command-line con-
trol tool

LABEXPRT\BIN\LABCMD.EXE

BootWorks LABEXPRT\BOOTWORK\BOOT\BOOTWORK.EXE
 1998, 1999 Altiris, Inc. page 14 of 40
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To apply a license, either select a license file in the top left window or click New, then enter the license inform
into the two edit boxes in the top middle. Select an executable in the lower left window and click Apply. To sto
information for later use, click Save and enter a filename.

When you select an executable in the lower left window, the current license information for that EXE is displa
the window to the immediate right. This allows you to see all licenses that have been applied to the EXE.

Note: You cannot apply the same license to an executable multiple times. If you try, an error message is disp

Create a user account 
The clients need to log into the LCS computer in order to run assigned batch files. Therefore, a user account
configured for this purpose. 

Use the appropriate network administration utility for your server to create a username “bootwork” without a p
word; otherwise you may need to type the password at each computer when it boots from the network. 

Note: For security reasons, do not use the “Admin” user for this purpose. Another user name should be creat
actual user name isn’t important, but it must match the name specified when creating a BootWorks install or 
disk.

You may also want to create “Login” or “Profile” scripts that arrange drive mappings so the user has access to
and directories of interest (directories accessed to perform work, such as directories that hold disk images, e
These steps are usually accomplished with the Client Install Wizard. However, if you wish to perform this wor
ually, a sample login script is shown below.

After the client has logged into the server the current working directory must be the directory containing the co
resource database in \LABEPXRT\DATA. The \LABEXPRT\BIN directory should also be put in the computer’s

Sample login script

PCCOMPATIBLE
map ins s1:=sys:labexprt\bin
map f:=sys:labexprt\data
drive f:

If you elect not to use a “Login Script” or “Profile” to set up the proper paths, make sure you indicate such as 
ate BootWorks install or boot disks.

Important:  Rights must be granted to the new user account so it can access (read, write, create, etc.) the ho
tory, as well as other directories the client uses in performing its work.

Control Console
The control console (LABEXP.EXE) is a Win32-based application that must be run on a Windows 95/98/NT c
The LabExpert Control Console (LCC) computer should have a network connection to the LCS with the curre
working directory mapped to the path where the files are installed. Or, both the LCS and the LCC can be the
computer.

The console is similar to the Windows Explorer utility with drag-and-drop capabilities. It contains two fields or
plays: a “tree” view on the left and a “list” view on the right. A sample screen of the console is shown in Figur
 1998, 1999 Altiris, Inc. page 15 of 40
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Figure 4: Control Console Display 

Each of the views are discussed below, followed by instructions on their usage.

Tree View vs. List View
The tree view on the left side controls what is displayed in the list view on the right side. The primary objects
tree view are “All Computers,” “Batch Files” and “Groups.” When a tree view object is selected, information re
to that object is displayed in the list view on the right as follows: 

All Computers
When you click the All Computers icon, icons representing each computer are displayed in the right frame. D
ing on what functions have been assigned, computer names, group names, batch files, addresses and status
displayed.

Groups 
One of the powerful features of the Control Console is the ability to create groups containing computers or su
groups. This allows you to organize your networked computers into logical groups and perform operations on
groups instead of only individual computers. 

All operations that affect computers (i.e., batch file assignments, reboot and execute instructions, etc.) applie
group are applied to all computers within the group and its subgroups. 

Right mouse clicking on a group displays a pop-up menu from which most group operations can be made.
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Figure 5: Pop-up menu 

Make assignment operations by dragging and dropping selected objects from the tree view or the list view on
group. This drag and drop method can be used to put groups within groups as well as computers within group

To take a computer out of all groups (so it is not a member of any group), drag the item(s) onto the Root nod
groups labeled ‘Groups’ (with the earth icon). 

Batch Files 
One of the primary functions of the control console is to provide a mechanism whereby DOS batch files can b
ated/edited and then “assigned” to the networked computers. The console provides an interface for maintain
ating/editing) these batch files before they are assigned to the computers.

The batch files in the current working directory along with any subdirectories or folders are displayed under th
‘Batch Files’ object in the tree view. Right mouse clicking on a batch file or folder displays a pop-up menu from
which most operations can be made.

The Edit option launches a text editor allowing you to modify an existing batch file. The contents of the batch
entirely up to you. The console displays the text after the first REM statement as the description for the batch

To “assign” a batch file to a computer, list of computers or group, you can:

• click the ‘All Computers’ object in the tree view to show a list of all networked computers. Select the des
computer(s) in the list view and drag the selection onto the desired batch file in the tree view.

• click the desired group and drag it onto the desired batch file.

• click the desired batch file and drag it onto either the group in the tree view or the computer in the list vie

Template Batch Files 
Altiris includes template batch files as a starting point for your configurations.They include batch files to resto
images and restore or manipulate registry files. The template batch files are located in \LABEXPRT\DATA\SAM-
PLES\TEMPLATE  and include the following.

• MASTER.BAT launches IBMASTER.EXE to download an image file and multicast it to slave computers.
can “chain” this batch file to one of the registry template batch files to finish a configuration setup.
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• SLAVE.BAT launches IBSLAVE.EXE. This batch file can “chain” to one of the registry template batch file
finish a configuration setup.

• REGUP.BAT uploads the registry files for either Windows 95/98/NT based on which registry tool is unco
mented in the batch file.

• REGDWN.BAT restores the registry files for either Windows 95/98/NT based on which registry tool is un
mented in the batch file.

• UDATEREG.BAT launches MREGFILE.EXE to create a .reg file on the target computer that can be impo
into the registry via Windows' REGEDIT.

• ONE.BAT launches IBMASTER.EXE to download an image file to the target computer WITHOUT multica
ing to any slaves. This batch file can “chain” to one of the registry template batch files to finish a configu
setup.

• MAKE-IMG.BAT launches IBMASTER.EXE to upload an image file from a client to the folder created un
\LABEXPRT\DATA.

Remote Control Agents
The Remote Control Agents are services or programs that run on networked computers and receive comman
the control console. These agents require access to either an IP or IPX protocol stack in order to receive com
from the console. The Remote Control Agents are located on the distribution media under \LABEXPRT\BIN.  

There are separate Remote Control Agents for Windows 95/98 and Windows NT. They are installed in the pr
partition of the master image computer when you run the Client Install Wizard and included in the image dow
to all other networked computers. 

If you want to manually configure the remote control agents, copy the appropriate agent (RCTRL9x.EXE  for Win-
dows 95/98, RCTRLNT.EXE  for Windows NT) into a directory on the networked computer. To update the Wind
Registry so the agent loads the next time Windows is loaded, type either

RCTRL9x -install or

RCTRLNT -install 

In Windows 95/98, the install process makes an entry in the registry at the key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunServices 

• In Windows NT, the agent gets loaded as a service viewable within the Services Control Panel.

Console Scripting Tool
The control console requires you to manipulate the computer resources in “current” time, meaning operations
formed via the control console happen immediately. 

The LABCMD scripting tool allows you to perform any of the operations normally performed via the control co
sole—such as creating groups, putting computers in groups, assigning batch files to the computers or groups
ing the computers, etc.—at the command line. 

Therefore, a “script” file can be built that makes all necessary manipulations to computer resources at some 
time through one of the scheduling programs provided by Windows NT or Windows 95/98. 

For example, if you desire all computers in an office to run the ImageBlaster Agent program at 2:00 am after 
one has left, you can write a “script” file containing the necessary LABCMD commands to start and control th
image process. 

Then you can schedule your NT or 95/98 computer to launch the script file at 2:00 am. The scripting capabilit
pled with the task mechanism make a very powerful management tool.

Warning: Care should be taken when creating the LABCMD commands since it has the ability to affect any 
computer resource in the resource database files, not just resources for the computer it is running on.

Usage
The LABCMD utility is a Windows 32 bit application and must be executed in Windows 95/98/NT.

The following should be noted: 
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• Capital letters indicate the required portions (minimum characters) that must be specified to make a vali
option. 

• Identifiers and operations can be combined on the same command-line. 

• Order of parameters is not important. LABCMD process them according to precedence. For example, if 
specify the -batch parameter along with the -r option, LABCMD assigns the batch file before rebooting th
computers. 

Status messages must be contained within quotes (“ “), i.e., “-status:Finished task #1” The status messa
be no longer than 40 characters. 

• Multiple/combinations of identifiers are allowed. For instance, if you specify a computer and a group on t
same line along with the -execute parameter, the computer as well as all computers in the group and its
groups receive the execute instruction. 

Creating a group with members and making the new group a member of another group is possible all in
command. For instance, 

C:> LABCMD name:C1 name:C2 -create:SubGroup2 -parent:ParentGroup1 

creates a new group called SubGroup2 and puts the computers named C1 and C2 into it, then makes th
group a subgroup of ParentGroup1. 

• The -delete parameter deletes the explicit elements listed on the command line, not the members. For in

C:> LABCMD name:Group1 -delete 

takes out all members of that group, then deletes the group itself. It does not delete the subgroups or the
ers within it. 

• There is a parameter of `@filename' that takes a list of identifiers as an input file. For instance,

C:> LABCMD @mylist.fil -batch:GO.BAT -reboot 

assigns GO.BAT from the current working directory and then reboots all elements listed in the input file. 

• Specifying the parameters -me and -reboot sends the reboot instruction as it normally does. You need to
sure the local computer is in the database and is running the appropriate agent. 

• You can export members of the groups by using the -export option. For instance, if you wish to move all
puters from one group another, you could export the members from the one group into a file, then use th
an import file in the next command, using the -parent parameter to make them members of the parent g

LABCMD returns the following error codes (usable with ERRORLEVEL in batch files): 

0 - Success 

1 - Invalid Parameter 

2 - Node Not Found 

3 - Conflicting Parameters 

4 - Database I/O Failure (after 60 seconds of retrying)

Process Builder
The LabExpert Process Builder (LEPRCBLD.EXE) utility automatically builds the template batch files for a ne
configuration.

• Creates a folder or directory under \LABEXPRT\DATA for the new configuration. For example, 
\LABEXRPT\DATA\CONFIG1.

• Creates all the template batch files.

Note: If you have any questions on the switches and usage for any of the tools used in these template batch 
please refer to the applicable usage section for that tool.

Computer Boot Commands 
Getting a networked computer to actually process a batch file is a two step process at the LCC. 

1. A batch file must be “assigned” to the computer as discussed above. This puts the batch file on the com
“virtual” floppy disk. 

2. The computer must be instructed to boot the virtual floppy in order to execute the newly assigned batch 
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These options are available:

Command to Boot Virtual Floppy
Rebooting Computers
Executing Commands Remotely
Optional Settings

Command to Boot Virtual Floppy 
Remember the BootWorks’ virtual boot ROM was likened to a virtual floppy. The batch file assignment proces
cussed earlier, changes the contents on the computer's virtual floppy. The control console is also the mechan
inserts/removes the virtual floppy into/from the computer’s “virtual disk drive.” This provides control for when t
computer actually processes the assigned batch files. 

The computer icon by each computer’s alias name indicates whether the virtual floppy is in or out of the com
virtual floppy drive. When the icon is green, the virtual floppy is “in” and the computer processes the batch file
ing its next boot. When the icon is white, the virtual floppy is “out” and the computer won’t process the assign
batch file but boots to its production partition instead. 

For the group icons in the tree view, a green icon indicates all members of the group will boot to the automati
mode. A gray icon indicates some of the members of the group will boot to the automation mode, while a wh
indicates no members of the group will boot to the automation mode. 

In Figure 5, the computers LAB21 - LAB24 are set to process their assigned batch files during their next boot.
remaining computers won’t, but will boot to their production system instead. 

To manage the boot command (whether the virtual floppy is in or out of the virtual floppy drive) for a compute
of computers or group, do one of the following.

1. Click the ‘All Computers’ object in the tree view to show a list of all networked computers. 

2. Select the desired computer(s) in the list view and right click. 

3. On the pop-up menu, select the desired boot command under the ‘Boot To’ option.

a. ‘Automation’ means the computer boots to the automation mode and processes the assigned batch
b. ‘Production’ means the computer won’t process the assigned batch file but boots the “production” o

ing system.
4. Click the desired group and use the pop-up menu as described in #3 above.

Hint:  You can also toggle a computer by double-clicking on its computer icon.

Rebooting Computers
If the computers are running one of the Remote Control Agents, they can be rebooted via the control console
reboot a computer, select the desired computer or group, open the pop-up menu with a right mouse click, an
the ‘Reboot’ option.

Important:  In order for the reboot mechanism to work, both the computer running the control console and the
puters to be rebooted must have a protocol stack loaded in memory

Executing Commands Remotely 
LabExpert can send execution commands to clients running the Remote Control Agents. This allows you to r
start programs that reside on the target computer. To send execution commands to a computer, select the de
puter or group, open the pop-up menu with a right mouse click and select the ‘Execute’ option. A dialog appe
where you enter the name of the application to launch.

Important:  Both the computer running the control console and the computers to be controlled must have the 
protocol stack loaded in memory (IP or IPX).

Optional Setting
The LabExpert Control Console has several options that can be customized for your convenience. To access
optional settings select View > Options. A sample options screen is shown in Figure 6. 
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Figure 6: Options Screen 

These options help you easily use the control console. Each option is described below.

Remote Control Commands 
Send Command Immediately - Selecting this option causes the console to send reboot commands as soon as
select the reboot function. 

Delayed by Groups - If you want a certain number of computers to reboot at a time with some interval betwee
groups of computers, select this option. 

Clear Status - Selecting this option causes the computer status field on the console to be cleared whenever a
command is sent to the computer. 

Prompt for Confirmation  - Selecting this option causes the console to prompt you for confirmation before sen
any reboot command. 

Help Files 
Allows you to specify the directory location of the HTML files supplied with LabExpert. 

Communication Protocols
Use pull-right menus - determines whether certain functions are accessed directly in one pop-up menu or by p
right on the pop-up menu. 

Boot to Automation - causes computers to be marked for boot to automation automatically when batch files a
assigned to them. 

Show Full Context - causes the console to display the full context of groups in the list view on the console.
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BootWorks Overview
The tools in LabExpert are stored on the Lab Control Server (LCS) and executed on the clients. However, Bo
software is installed on each computers’ hard drive or run from a floppy disk. BootWorks controls the compute
sequence and connects the computer to the network during automation mode. 

BootWorks Options
The batch/boot control process requires that BOOTWORK.EXE be executed on each lab computer during au
tion mode. This can be accomplished in one of two ways. 

A. The BOOTWORK.EXE utility along with the proper LAN drivers and client software for 
your network can be permanently installed on the lab computer’s hard drives. 

B. BOOTWORK.EXE utility can be put on a bootable floppy disk containing the proper LAN drivers and clie
software for your network. There are pros and cons with each method. 

BootWorks installed on a hard drive acts like a ‘virtual floppy’, controlling the boot sequence of the computer e
time it boots. When some sort of automation work is to be performed on the computer, BootWorks causes the
puter to “boot” from the virtual floppy (automation mode). When no automation work is intended, BootWorks c
the computer to “boot” normally into the OS installed on the workstation (production mode). 

This means the computer is always ready to perform automation work. Each time the computer boots, it chec
LabExpert control database and immediately processes any pending automation scripts. There is no need to 
computer to insert a floppy disk each time automation work is to be performed. However, this requires an ‘au
tion’ partition (4 MB) be created on the hard drive to house BootWorks. 

BootWorks installed on a floppy disk removes the need for an ‘automation’ partition on the computer’s hard d
but it also requires the floppy disk to be manually inserted into the computer’s floppy drive each time automat
work is desired. This means the floppy must also be manually removed after automation work before the com
can boot to ‘production’ mode. 

In other words, BootWorks installed on the computer hard drive provides total ‘hands-off’ automation at the e
of some drive space, while BootWorks on a floppy requires operator intervention during some portion of the a
tion work.

Note: To take full advantage of the automation capabilities in LabExpert, it is recommended that BootWorks b
installed on each lab computer’s hard drive.

BootWorks Installed On Hard Disks 
When BootWorks is installed on a hard disk, it creates a 4 MB default size partition at the beginning of the ha
(in slot one of the partition table) and installs DOS in that partition. This partition must also contain the prope
drivers for the computer’s NIC, along with the network client software needed to establish a connection with t
LCS. 

This partition is referred to as the “automation” partition (see Figure 7) since most automation processes occu
DOS execution from this partition. 
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Figure 7: BootWorks Drive Configuration

Important:  If you want to install BootWorks onto a computer already containing a desired software configurat
(OS, applications, etc.) and there is no free space at the beginning of the drive to accommodate the automat
tion, please refer to the IBMIGRATE utility for a work around.

Warning: You should have a license for each copy of DOS you use.

BootWorks also replaces the code in the computer’s master boot record (MBR). The master boot record code
the automation partition gains control during the computer’s boot sequence. 

Each time the computer boots, the MBR code causes the computer to boot to DOS where the LAN drivers an
software are loaded and a connection is established with the LCS. 

The control database on the LCS is examined to determine if there is work (a batch file) for the computer to d
on the network. If there is work to do, the work is performed. 

If there is no work, the network client and LAN drivers are removed from memory and the computer does a s
to run the “normal” operating system (contained in a partition referred to as the “production partition”). The pr
of loading DOS and checking the data stored on the LCS takes only seconds. 

Automation Partition Drive Assignments 
It is important to understand how the automation partition interacts in relation to other partitions that may be o
drive during the “automation mode” and the “production mode.” 

Automation mode is the time when the computer boots DOS from the automation partition and processes an
assigned automation work. Production mode is when the computer boots the “normal” operating system foun
production partition. 

Operating systems typically assign a drive letter to all partitions and file systems they recognize so the opera
gain access to these file systems. 
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For example, if a computer has a primary partition with Windows 95/98 and an extended partition with two lo
drives, drive letter C: is assigned to the primary partition (operating system files) while drive letters D: and E: 
assigned to the two logical drives in the extended partition. Drive C: is always assigned to the bootable partiti

The following tables show how drive letters are assigned to the production and automation partitions in both a
mation mode and a production mode.

From the above table, it is important to note the following: 

1. Because DOS understands the production file system, a drive letter is assigned to this file system while 
mation mode. This allows access to automation tools like the registry managers in the production file sy

2. By default, the BootWorks agent, which is executed in automation mode and launches assigned batch fil
switches the drive letter assignments so the production partition is referenced as drive C:. This allows yo
write automation batch files using drive letters as if you were in production mode. 

3. There is no drive letter assigned to the automation partition file system while the computer is in productio
mode because the partition is marked “INVALID” and hence not recognizable by the production operatin
tem. This prevents users of the computer from accidentally accessing and changing data in the automat
tion. 

From the above table, it is important to note the following: 

A. Because DOS does not understand the production file system (FAT32, NTFS, HPFS, or 
UNIX), a drive letter is NOT assigned to this file system while in automation mode. The

Table 4: Drive Assignments for FAT 12/16 File Systems

Automation Mode 
before BootWorks

Automation Mode 
during/after Boot-
Works

Production 
Mode

Production 
Partition 

(FAT)
D: C: C:

Automation 
Partition (FAT) C: D:

No drive letter. 
Partition 
marked 
INVALID

Table 5: Drive Assignments for FAT32 & non-FAT file systems

Automation Mode 
before BootWorks

Automation Mode 
during/after Boot-
Works

Production 
Mode

Production 
Partition 

(FAT32, NTFS, 
HPFS, UNIX)

No drive letter No drive letter C:

Automation 
Partition (FAT) C: C:

No drive letter. 
Partition 
marked 
INVALID
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fore automation tools such as the registry managers CANNOT access the production f
tem. 

B. Since there are no other drive letters assigned, BootWorks cannot switch drive letters. Hence, the autom
partition remains as drive C:. 

C. There is no drive letter assigned to the automation partition file system while the computer is in productio
mode because the partition is marked “INVALID” and hence, not recognizable by the production operatin
tem. This prevents users of the computer from accidentally accessing and changing data in the automat
tion. 

Automation Partition Sizing 
Because the automation partition is visible and usable during automation mode, but not visible or usable duri
duction mode, the automation partition acts like a second drive in the computer connected during automation
and disconnected in production mode. The size of this “second” drive (the automation partition) defaults to 4 M
can be sized from 4 MB up to 2,000 MB when creating the BootWorks install disk. 

Size the automation partition to store data such as images or registry sets in this partition instead of on the n
server. This means “snapshots” of the computer can be stored “locally” without using disk space on the serve

For example, a computer is used for a particular task (task #1) from 8:00 a.m. to 5:00 p.m. The same comput
for a completely different task (task #2) from 6:00 p.m. to 10:00 p.m. ImageBlaster Agent takes a “snapshot” 
of the computer as task #1 at 5:15 p.m. and stores the image locally in the automation partition. 

Then, task #2 image is placed on the computer for use at 6:00 p.m. At 10:15 p.m. ImageBlaster Agent restore
image (snapshot image created at 5:15 p.m.) to the production partition making the computer ready for the ne
a.m. session. 

In other words, the automation partition can be used for a sort of “Image Task Switching” without using any dr
space on the server. This can be completely automated by using scheduling utilities such as Windows NT AT.

The REGUP.BAT and REGDWN.BAT files can be used to replace the registry files so each user gets the sam
uration as when they last left.

BootWorks Install
The BootWorks install program must put the automation partition at the beginning of the hard drive and must
definition for this partition in the first slot of the partition table. 

If you already have an operating system on the hard drive, its partition is most likely defined in the first slot. T
BootWorks install program moves, at your okay, the existing partition definition in slot 1 to another free slot so
put the automation partition definition in slot 1. 

Warning: This causes a problem with Windows NT because NT maintains partition information on its boot 
partition. IT IS HIGHLY ADVISED THAT YOU REMOVE ANY EXISTING OPERATING SYSTEM 
FROM YOUR HARD DRIVE BEFORE RUNNING THE INSTALL PROGRAM  (or let the install program 
remove it for you—see the following), install BootWorks, re-install your operating system, and re-install the Bo
Works master boot record (in that order).

The install program has several command-line options allowing you to customize the installation procedure. I
cases, the default options are sufficient. However, there may be times when customizations to the install prog
needed for your environment. These options are described below.

On each target computer, boot the install floppy. The BOOTWORK install program runs automatically. Phase
the installation checks requirements and performs preliminary setup work. After phase one completes, the co
automatically reboots and runs phase two of the installation. You must leave the floppy in the disk drive while
phases of the installation are running. 

Phase One
Phase Two
Starting Bootworks for the first time
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Phase One 
The installation program checks to see if there’s room at the beginning of the hard disk for the automation pa
The automation partition requires a minimum of four Megabytes of disk space (rounded up to the next wholeylin-
der), located at the beginning of the physical media. If this space on the disk is used by another partition, you
option of exiting the install program or allowing the install program to automatically (and destructively) remov
overlapping partition. 

The installation program then checks to make sure the first slot in the partition table is available. If an existing
tion is found in the first slot of the table, you can choose to erase the partition, move it to a different slot (not 
mended), or quit the install. The following message and prompt is displayed if an existing partition is found in
first slot of the partition table (the message is long because it's warning of the potentially destructive nature o
“move partition” choice): 

The automation slot in the partition table is occupied by an existing partition, but I need that partition-tab
to create the automation partition. You have three options from which to choose: 
(E/M/Q).

• (E)rase the existing partition to make room for the automation partition.
• (M )ove the existing partition to slot 2 (which is currently unused), thus freeing up the automation pa

slot. 
Note: Some operating systems contain partition-slot-dependent configuration data that becomes in
you elect to Move their partition. These operating systems are rendered unbootable if you move the
tition slots without first updating their partition-slot-dependent files. 

For example, Windows NT contains a 'partition(n)' specifier in the boot.ini file which controls where
operating system finds boot files. If you are running Windows NT on this system, you need to make
no entries in the boot.ini file refer to partition 1 before you let me Move the partition to slot 2. You sh
change any strings of the form 'partition(1)' to 'partition(2)' just prior to running this installation progr
That way, when I move the partition, you'll have already updated the boot.ini to point to the new par
and the operating system will still be able to find its boot files. 

• (Q)uit the program and don't modify the disk. 

If an existing partition contains a special “automation partition” signature, the install program tells you it has fo
an existing automation partition. You have three options. 

a. You can remove that partition and reinstall the automation partition from scratch (e.g., to load new odif-
ferent LAN drivers).

b. You can leave the automation partition and its contents alone and choose only to rewrite the Maste
Record code (useful if some other program has overwritten the MBR sector). 

c. You can also abort the program if you want neither of these options. 

If an automation partition already exists, the following prompt is displayed: 

I've found what appears to be an existing automation partition in the automation slot of the partition table
have some options from which to choose: (E/K/Q)

a. (E)rase the existing partition and recreate it from scratch. 
b. (K)eep the existing partition, but rewrite the program in the disk's Master Boot Record. 
c. (Q)uit the program and don't modify the disk.

If the “Keep” option is selected, the install program rewrites the MBR code only (and the installation is comple
Otherwise, the install program creates a new partition on the disk. 

This partition always occupies the first slot in the partition table, and the partition itself is always located at th
ning of the physical media. 

The install program also “hides” the other partitions on the disk so they won’t be disturbed during phase two o
installation. 

The install program then writes a “phase one complete” stamp in the automation partition and reboots the com
This reboot is needed for DOS to recognize the new partition so it can be formatted.
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Phase Two 
When the computer boots the second time, the install program runs again. This time, the install program dete
“phase one complete” flag and proceeds to run phase two of the install program. The install program calls the
format program to format the automation partition. 

After the format is complete, the install program calls the COPYDOS.BAT file to copy DOS to the automation
tion. Then the COPYNET.BAT file is called to copy the LAN drivers to the automation partition. 

Following this, the original partition entries are restored and the MBR boot code is overwritten with a special p
gram that boots the automation partition on each subsequent boot of the computer.

Installation Command Line Options
Command-line switches enable you to “preload” your decisions so you don't need to respond to the prompts 
lation time.

If all installation pre-conditions are met (or can be met given suitable operator input), the installation program 
the automation partition and reboots the computer. When the computer reboots, phase two of the installation 
automatically from the AUTOEXEC.BAT file. This phase performs the following tasks. 

• Formats the automation partition

• Copies DOS files to the automation partition

• Copies LAN driver files to the automation partition

• Writes new code in the Master Boot Record

Table 6: Available Install Switches

+b On IDE drives, allows you to force the use of CMOS to establish 
the maximum cylinder setting.

-u Removes the automation partition from disk and restores the origi-
nal Master Boot Record code. Do NOT put this switch in a batch 
file, but you can use it interactively if you need to remove the auto-
mation partition. 

-c Checks for the presence of the Altiris’ Master Boot Record on the 
disk. The program prints a message indicating the presence of Alti-
ris’ MBR code and then exits with one of the following status 
codes: 
0 - Altiris’ MBR code is present on the disk
1 - Altiris’ MBR code is NOT present on the disk
2 - An error occurred while reading the MBR sector

-mbr Re-writes Altiris’ Master Boot Record (MBR) code to the hard 
drive and then exits. This is useful after installing an operating sys-
tem that overwrites the MBR. 

-sX Creates the automation partition X Megabytes in size. If a % char-
acter follows X, the automation partition is created as the specified 
percentage of the hard drive.

-ms Invokes the FORMAT utility with options that work with MS-DOS. 
If a version of DOS other than the supplied Caldera OpenDOS is 
desired on the automation partition, this switch must be used. 
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OS Considerations
This section discusses how BootWorks acts with different operating systems and how to work with them. The
ics include the following:

Master Boot Record
Partition Slot Dependencies
Windows NT

Master Boot Record 
When BootWorks is installed, it replaces the Master Boot Record on the disk. This is the first sector on the ha
The BootWorks installation procedure also saves the original MBR code in the second sector on the hard dis
code can be used for “production” boots.

Some operating systems overwrite the Master Boot Record code when they are installed. This overwrites Alt
BootWorks MBR code, which disables the BootWorks software on that computer. If this occurs, you need to r
BootWorks install program again to place Altiris’ MBR code back on the disk. 

When the install program runs, it detects the existing automation partition at the end of the disk and gives yo
option of rewriting the MBR code instead of reinstalling the automation partition from scratch. If you select the
“Rewrite MBR code only” option, BootWorks software is re-enabled, and you don't have to run the entire two-
installation. You can also use the install program's -mbr command-line switch to only rewrite the MBR code in
of running a two-phase installation. 

Partition Slot Dependencies 
One of the installation requirements for BootWorks is that the first slot in the partition table be free so BootWo
install the entry for the automation partition in the first slot of the partition table. 

If the first partition slot is occupied, the install program prompts the operator to either move the existing partit
entry to a different slot or remove the partition entirely. 

Clearly, removing the partition is destructive and moving the partition entry to a different slot would normally b
preferred alternative. In some cases however, moving a partition renders the partition as unusable as if it had
deleted. 

The key factor in determining if a partition is “slot dependent” or “slot independent” is the operating system's k
edge of the partition slot. DOS, for example, does not store partition slot information so it doesn’t “know” the p
tion-table-slot occupied by a particular drive letter. So it is safe to move a DOS partition from one slot in the pa
table to another. 

Windows NT does have partition-slot knowledge (e.g. in the BOOT.INI file), and this is why it can be destruct
move a Windows partition-table entry from one slot to another. Other operating systems might also store parti
information on the disk, so they exhibit the same slot-dependent behavior as Windows NT. 

+q Queries the user to confirm various stages of installation. When 
“query mode” is enabled, the user is prompted before several 
actions are performed including: 
23 Writing to the MBR sector 
24 Stamping the OEM BPB field in automation partition 
25 Rebooting the computer

-q Disables “query mode.” This is the default setting. 

+v Explains in verbose mode while installing. Use this switch at the 
request of Altiris’ technical-support staff to aid in debugging instal-
lation failures.

-v Disables “verbose mode.” This is the default setting.

Table 6: Available Install Switches
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Windows NT 
Here’s a summary of the anomalies we know about Windows NT. It’s important to note there may be other un
partition-slot dependencies stored in the OS. 

IT IS HIGHLY ADVISED THAT YOU REMOVE ANY EXISTING OPERATING SYSTEM FROM YOUR HARD 
DRIVE BEFORE RUNNING THE INSTALL PROGRAM 

(or let the install program remove it for you—see below), install BootWorks, re-install your operating system, 
then re-install the BootWorks’ master boot record, if necessary.

Microsoft claims neither the presence nor the absence of partition-slot-dependent information in Windows NT
impossible to know for sure if such dependencies exist. This means “move partition” procedures described be
may cause bizarre and seemingly inexplicable software malfunctions. 

If such a malfunction is encountered, it probably means there is some partition-slot-dependent information tha
wasn’t updated when the partition was moved. The point is, there’s no way to be absolutely sure that moving
partition is safe. Here’s what we do know about NT.

• NT stores partition-dependent information in the root directory of the boot partition in a hidden file name
BOOT.INI. This file contains information about the partition table slots containing NT partitions and this i
where NT maintains knowledge of the partition slot. 

If the information in BOOT.INI doesn’t match the contents of the partition table, NT won’t boot properly, w
is why changing the partition table contents can be dangerous. If the BOOT.INI file and the partition table
in sync, NT won’t boot. 

• If, when installing BootWorks software, it becomes necessary to move an NT partition (we don’t recomm
it), then you need to edit the BOOT.INI file immediately prior  to the installation of BootWorks software. 

To find out which values to change in the boot.ini file, run only the first part of the BootWorks install prog
When it detects a partition in the first slot of the partition table, it tells you where it needs to move the pa

Warning: Do NOT allow the install program to move the partition yet!
Write down this new partition slot information and exit the BootWorks installation. Then boot NT, and edit th
boot.ini file to refer to the “new” partition locations. 

Boot using the BootWorks install floppy again, and this time let the install program move the partition. By
lowing this procedure, you can make sure the partition table and the BOOT.INI file are in sync, and hope
NT continues to be bootable. 

Warning: If you make any mistakes when editing the boot.ini file, your system becomes unbootable. 
The BOOTWORK install program must put the automation partition at the end of the hard drive and mus
the definition for this partition in the first slot of the partition table. 

Running BootWorks
BOOTWORK.EXE is the main component of the BootWorks technology. Each of the BootWorks components
customized for various environments.BOOTWORK.EXE is located on the “automation partition” on each com
hard drive or on a bootable floppy, depending on how you configure your computers. BOOTWORK.EXE deter
if there is work to be done while on the network and when the “production partition” should be booted.

BOOTWORK.EXE scans the BOOTWORK.BIN file on the LCS. If the computer’s MAC address is found in th
BOOTWORK processes the entry and determines if there is work to be done or if it should boot the “productio
tition.

If customizations to the BOOTWORK utility are needed for your environment, make them in AUTOEXEC.BAT
residing in the automation partition or on the boot floppy. The BOOTWORK utility is invoked there and allows
to add command-line switches. You can also customize the automation batch files on a per-computer basis u
environment variable.

Table 7: Available BootWork Switches

-w Causes BOOTWORK.EXE to continue to scan BOOTWORK.BIN 
until there is work to be processed while in the automation mode.
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-hr Causes BOOTWORK.EXE to do a hard reboot (which is slower 
because the computer completes the entire POST phase - count mem-
ory, etc.) when it tries to boot into the “production” partition. If the 
computer hangs when booting into the production partition (soft 
boot), try using the -hr switch to force a different type of boot. 

-p Causes BOOTWORK.EXE to pause before booting the production 
partition. With this switch, the operator must press a key before the 
production partition is booted. 

-ns Causes BOOTWORK.EXE NOT to shift drive letters when running 
automation batch files. When a computer boots a DOS partition, such 
as the automation partition, it assigns the drive letter C: to the parti-
tion. If other DOS partitions (FAT file system partitions) are detected 
on the hard drive, subsequent drive letters (i.e. D:, E:, etc.) are 
assigned to the other partitions.
For example, if a computer contains Windows 95/98 in the produc-
tion partition and Caldera OpenDOS in the automation partition, 
drive letters are assigned as follows upon an automation boot: drive 
C: is assigned to the automation partition (Caldera OpenDOS) and 
drive D: is assigned to the production partition (Windows 95/98).
Normally, BootWorks shifts these drive letter assignments so C: 
points to the production partition (if it is FAT file system based) and 
drive D: points to the automation partition. This allows batch files 
that work with files on the production partition to use drive letter C: 
to access the partition. 
When the BootWorks tool exits, all drive letters are switched back to 
normal assignments. The -ns switch causes BootWorks NOT to shift 
the drive letter assignments, keeping the normal assignments valid 
during the processing of batch files. This means a batch file referring 
to drive C: would actually access the automation partition instead of 
the production partition.

-f Causes BOOTWORK NOT to modify the partition table when per-
forming a “production” boot. Normally, BOOTWORK.EXE sets a 
flag in the partition table on the boot disk to notify the MBR code that 
a “production” boot is desired. The -f switch prevents these modifica-
tions, thus allowing BootWorks to be run on a computer that has no 
automation partition installed, or to be run from a floppy disk (the “f” 
switch stands for “floppy operation”). 

-a Causes BootWorks to use the specified alias name when searching the 
LabExpert control database for assigned work. Normally, BootWorks 
uses the computer's MAC address to retrieve the computer's alia
name from the control database. This switch overrides the MAC 
address lookup on the control database and forces BootWorks to use 
the specified name. The entire command line switch must be sur-
rounded by “ ” (double quote marks, i.e. “-a Computer 1”) NOTE: 
The -a switch must replace the -w switch. They CANNOT be used at 
the same time. 

-l Causes BOOTWORK to display all licenses that have been applied to 
the executable.

Table 7: Available BootWork Switches
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Environment variables
If you have configured the BOOTWORK utility to use BOOTWORK.BIN, you can use an additional feature to 
tomize your automation batch files. Each computer’s name or alias is stored in BOOTWORK.BIN. 

Prior to executing the automation batch file, BOOTWORK.EXE sets the environment variables called NODEN
and NODEFULL. NODENAME contains up to the first eight characters (or up to the first SPACE character) o
computer’s alias or name. NODEFULL contains the entire alias name; it isn’t limited to the first eight characte

This allows you to customize automation batch files with constructs such as these:

echo %NODENAME% >c:\node.id

copy f:\stuff\%NODENAME%\config.sys c:\config.sy

The first line creates a file called node.id on the computer’s local hard disk and populates this file with the com
name. The second line copies a file from a computer-specific directory on a network server and stores it on th
hard disk. 

By maintaining a set of directories (under f:\stuff  in this example), you can maintain per-computer configurati
files on your server. Using this mechanism, you can collect information from each computer and store it on th
or you can distribute information from the server to individual clients. 

Starting the BootWorks client for the first time 
Each time the BootWorks client boots, it examines the resource database on the LCS to determine if there is a
to be executed. 

When a computer first boots after BootWorks has been installed on its drive, it detects that it is not yet identifi
the resource database and prompts you for a name. This is the alias name that is displayed on the control co
can make the name anything that helps you identify that particular computer.

Important:  Several of the tools use the first eight characters as a unique ID for the computer, so you may wa
ensure the first eight characters are unique across all the computers.

Disk Imaging 
Included in the LabExpert suite of tools are the disk imaging utilities used to set up and configure your resour
These utilities are grouped under the ImageBlaster Agent technology and are detailed in the User Manual at the Alti-
ris’ Web site. It contains information and instruction on the operation of these tools.

Registries Management 
After computers have been imaged, the contents of their hard drives EXACTLY match the image of the comp
from which the image came. Windows 95/98 and Windows NT keep specific information relative to the compu
hardware (i.e., IDE drive controller chip set, video chip set, etc.) in their registries. 

If an image is created on one vendor’s computer and subsequently restored to another vendor’s computer, the
ware entries in the registry may not match the local hardware.

Windows 95/98 then goes through several “processes” discovering the correct hardware and updating the reg
entries. Windows NT is less forgiving—it might not even boot. LabExpert contains registry-management tools
help resolve problems associated with registry settings. 

Along with hardware-specific entries, the registry contains other information that might need to be unique for
computer—such as computer name, IP address (if hard coded), user name, etc. 

LabExpert has two types of registry management tools:

• those that control archiving of the registry files (95REGMGR.EXE and NTREGMGR.EXE). These are usually 
called by the REGUP.BAT and REGDWN.BAT files when called by the IBMASTER or IBSLAVE batch files

• those that allow you to change only specific registry key values by making a .reg file to be imported into 
istry (MREGFILE)

These tools are presented below. 

Note: These registry managers only manage registry files loaded on FAT 12/16 file systems and FAT 32 
you’re using Windows 95/98 DOS. They DO NOT manage registry files on NTFS file systems.
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95REGMGR and NTREGMGR
These registry tools help make (or restore) unique registries to each computer by archiving the registry files o
LCS and then restoring them when needed. The process involves creating an image on one computer and re
it to all desired computers using the ImageBlaster Agent. 

Each Windows 95/98 or Windows NT computer goes through its hardware detection routine, making necessa
changes for computer name, IP address, etc. 

After the registries are properly configured, use 95REGMGR or NTREGMGR to archive the registries on the
The next time the image is restored to the computers, 95REGMGR or NTREGMGR restores previously save
try files. This saves time and operator intervention. 

To make sure registry files are restored to the proper computer, they are copied to a unique file name on the 
based on the computer’s MAC address as follows: 

YYYYYYYY.SDT - system registry file 

YYYYYYYY.UDT - user registry file

where YYYYYYYY = last eight numbers of computer’s MAC address.

Important:  In order for the registry tools to obtain the computer’s MAC address, a protocol stack must b
loaded in the computer’s memory.

Usage

95REGMGR [switches] 

-U Upload registry files (archive) 

-D Download registry files (restore) 

-Ly Local path to registry files y = path 

-Ry Remote path to registry files y = path 

-Naaa Don't process registry file aaa where aaa = 

sdt (system.dat)

udt (user.dat)  

NTREGMGR [switches] 

-U Upload registry files (archive) 

-D Download registry files (restore) 

-Ly Local path to registry files y = path 

-Ry Remote path to registry files y= path 

-Naaa Don't process registry file aaa where aaa = 

stm (system) 

sft (software) 

sec (security) 

sam (sam)

def (default) 

The local path (-l) is the location on the local drive where the registry files are located. For Windows 95/98, th
typically c:\windows . 

For Windows NT, the path is typically c:\winnt\system32\config

The remote path (-r) specifies the location on the LCS where the registry files are to be stored and retrieved.
path name is specified, not a file name. 

The (-U) and (-D) flags are used to specify which type of operation is to be performed. (U)pload archives the 
files to the LCS. (D)ownload restores the registry files from the LCS back to the computer. 

The (-N) flag can be used to specify registry files that should not be processed.
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MREGMGR
The MREGFILE utility performs three functions:

• acquires the first eight characters of the computer’s ID from the environment variable set by BootWorks

• scans the master file specified on the command line for lines of text associated with the computer’s ID

• copies the lines of text to a user-specified file. This file can then be imported into the Windows 95/98 or W
dows NT registry by using the REGEDIT utility. 

With MREGFILE you can customize specific registry properties without having to manually enter the changes
each computer. 

The process involves using REGEDIT to:

• find the desired registry keys for the properties to be changed (i.e., IP addresses, computer names etc.)

• export these keys to a .REG text file

• group the individual keys into a “master” registry data file

• cut and paste copies of the set of keys for each computer

• make the necessary changes to the properties for the various keys. 

Example

An example “master” registry data file is shown below. 

REGEDIT4 

{Brian_1} 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

control\ComputerName\ComputerName] 

“ComputerName”=”STRESS1” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\VNETSUP] 

“ComputerName”=”STRESS1” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\MSTCP

“HostName”=”STRESS1” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\Class\Neutrals\0006] 

“IPAddress”=”207.49.11.25” 

“IPMask”=”255.255.255.192” 

“DefaultGateway”=”207.49.11.62” 

{Chris_2} 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

control\ComputerName\ComputerName] 

“ComputerName”=”STRESS2” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\VNETSUP] 

“ComputerName”=”STRESS2” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\MSTCP

“HostName”=”STRESS2” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\Class\Neutrals\0006] 
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“IPAddress”=”207.49.11.26” 

“IPMask”=”255.255.255.192” 

“DefaultGateway”=”207.49.11.65” 

{Eric_3} 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

control\ComputerName\ComputerName] 

“ComputerName”=”STRESS3” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\VNETSUP] 

“ComputerName”=”STRESS3” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\MSTCP

“HostName”=”STRESS3” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\Class\NetTrans\0006] 

“IPAddress”=”207.49.11.27” 

“IPMask”=”255.255.255.192” 

“DefaultGateway”=”207.49.11.62” 

Notice the computer ID “tag” for each computer (i.e. {Brian_1}). The MREGFILE utility copies the lines followi
the computer ID tag to the local file specified on the command line. Using the example file above, the conten
local file for computer ID Brian_1 would be:      

REGEDIT4 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

control\ComputerName\ComputerName] 

“ComputerName”=”STRESS2” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\VNETSUP] 

“ComputerName”=”STRESS2” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\VxD\MSTCP

“HostName”=”STRESS1” 

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\ 

Services\Class\NetTrans\0006] 

“IPAddress”=”207.49.11.26” 

“IPMask”=”255.255.255.192” 

“DefaultGateway”=”207.49.11.65” 

This local file can be imported into the local registry using the REGEDIT utility. To automate this process, cre
batch file such as the following which is executed each time the operating system loads. In order for this sam
file to work properly, the local file specified on the command line for MREGFILE would be

“c:\newreg.reg ”. 

IF NOT EXIST C:\NEWREG.REG GOTO NO_UPDATE 

C:\WINDOWS\REGEDIT C:\NEWREG.REG 

DEL C:\NEWREG.REG 

:NO_UPDATE
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To make Windows 95/98 process the above batch file each time Windows 95/98 is loaded, put the command 
the batch file in C:\AUTOEXEC.BA . If the above batch file were named STARTREG.BAT, the entry in the 
AUTOEXEC.BAT file would be: 

CALL C:\STARTREG.BAT

MREGFILE Switches

-B Not using BootWorks(tm), try NDS for name search

-Ly Local path to reg file (y = path and name)

-Ry Remote path to master registry file (y=path and name)

REGUP.BAT and REGDWN.BAT
REGUP.BAT provide the capability to record (make an image of) one or more computers and store them on t
Whether you’re in a 24 hour work environment with three different users per computer, per day or a classroom
students who just have to customize their computers, you can restore each computer’s registry files as often 
need to with REGDOWN.BAT

REGUP.BAT and REGDOWN.BAT are often run in conjunction with other imaging options. However, you can
restore a user’s registry anytime by assigning the REGDWN.BAT file from within the LCC (LabExpert Control
sole) and causing the computer(s) to reboot. You can even automate the process using a Windows schedule
download occurs at the same time every day.

Power Tools
A collection of miscellaneous tools is provided with LabExpert to facilitate setup and configuration. They are u
chain tasks in a sequence, help finish setup after computers have been imaged, gather data from the compu
test runs, and other general computer maintenance. This section briefly describes each. NextStep

Many setup and configuration tasks for the lab computers require several events to happen in a sequence. T
Step tool allows a computer to manipulate its own properties in the resource database (BOOTWORK.BIN) an
allows the chaining of events to occur. 

Unlike the LABCMD utility which manipulates properties for any computer in the resource database, NextSte
only affect properties for the computer on which it is executed. It cannot change the properties of any other c
in the lab.

NextStep is a DOS-based utility that must be run from a DOS prompt or batch file . This utility searches the da
and makes changes to this computer's entry. This cannot make changes to any other computers’ listed. To c
other entries, use the Win32 console application or the Win32 GUI tools. 

Command line options

Syntax: nextstep <function(s)>

Functions:

Batch:<batch_file> (Assign a batch file to run)

Unassign (Unassign from all batch files)

Automation (Boot to automation)

Production (Boot to local production partition)

Status:<message> (Set the status message)

Reboot (Reboot this computer)

The command line options for NextStep are listed in the help screen above. The following should be noted:

• Capital letters indicate the required portions (minimum characters) that must be specified to make a valid
option.

• Order of parameters is not important. NextStep processes them according to precedence. For example,
specify the -batch parameter along with the -r option, NextStep assigns the batch file before rebooting th
puters
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• Status messages must be contained within quotes (“ “). (i.e. “-s:Finished task #1”) The status message m
no longer than 40 characters.

NextStep returns the following error codes (usable with ERRORLEVEL in batch files):

0 - Success

1 - Invalid Parameter

2 - Node Not Found

3 - Conflicting Parameters

4 - Database I/O Failure (after 60 seconds of retrying)

Example

The following example is given to help you understand the power and use of the NextStep tool.

The process of restoring a Windows 95/98 image to a computer, along with its original registry settings, is a tw
process requiring two separate batch files: one to invoke the imaging process and one to restore the original 
settings via the 95REGMGR tool. 

The NextStep tool can be used in each batch file to cause a “chaining” of steps so they are performed in seq

The first batch file contains:

@echo off

rem Download Win 95 image

ibmaster -md -ff:\labexprt\images\win95.img

nextstep “-s:Finished win95 image” -b:demo\put95reg.bat -r

This batch file invokes the IBMASTER tool to download (restore) the image file f:\labex-
prt\images\win95.img  to the local computer. 

When the imaging is complete, the NextStep command sends the status “Finished win95 image” to the contr
sole, assigns the computer to run the “put95reg.bat” batch file in the demo directory during its next boot, and 
the computer.

The second batch file contains:

@echo off

rem Put Win 95 registry files on computers

95regmgr -d -lc:\windows -rf:\labexprt\images\95reg

nextstep “-s:Put 95 reg files on computer” -p -r

This batch file invokes the 95REGMGR tool to restore the registry entries stored in the f:\labex-
prt\images\95reg  directory. When this process is completed, NextStep sends the status “Put 95 reg files
computer” to the control console, assigns the computer to boot to “Production” mode during the next boot and
reboots the computer.

To complete the entire restoration process, assign the first batch file to the computer via the control console o
CMD utility and walk away. The computer performs each step in sequence.

UPLOADDB
UPLOADDB reads data from a user-specified file on the local computer (source file) and appends it to a user
fied file on the LCS (destination file). If this tool is executed on several computers and the same destination f
specified, the contents of all source files are stored in the same destination file. This mechanism can be used
results of a test stored on networked computers and then compile them into a single file on the LCS. 

UPLOADDB inserts the first eight characters of the computer ID of the local computer into the destination file 
appending the contents of the source file. This identifies the data received from each computer in the destina

Usage 

UPLOADDB <localfilename> <reportfilename> 

The local file name is the name of the source file on the local computer, and the report file name is the n
the destination file where the source file is appended.
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COMPID
The COMPID utility acquires the first eight characters of the computer’s ID from the BootWorks database and
it to a user-specified file (generally on the computer’s hard drive). This file can then be used by other tools, ba
files, etc., as a unique name/ID for customization purposes. 

For example, if the computer needed to log into a server with a unique user name, the contents of the COMP
could be used as the login name. 

Usage 

COMPID id_file_name 

The id_file_name is the name of the file where the computer ID is written.

IBMIGRATE
The IBMIGRATE utility allows you to use a disk image from a computer without an Automation Partition, on c
puters with an Automation Partition. IBMIGRAT.EXE shifts the Partition Entries in the Partition Table up one s
prevent a conflict with the location of the Automation Partition, which is always in slot one. IBMIGRAT.EXE al
the Master Boot Record using information from the BOOTORG.BIN file so it contains the proper information.

The drive is now ready to be imaged and IBMASTER.EXE is launched. The image is created and when IBMA
TER.EXE is finished, the Master Boot Record is restored to its original state. 

Usage 

Note: For Windows NT only, when using IBMIGRAT.EXE on a partition containing Windows NT, it’s neces-
sary to first edit the BOOT.INI file to change the “...partition(n)...” entries to represent the new slot in the 
tion table. For example, change ...partition(1)... to ...partition(2).... When making this change, it is neces
remove the Read Only flag before making the change and resetting it when done.

1. Boot the computer using an Automation Boot Disk. See “Creating BootWorks Boot Diskette”. Enter the C
puter Alias name if the Not Found message is displayed. This registers the computer in the database. 

2. Reboot using the same Automation Boot Disk. When the message “Waiting for work. Next check in ...“ ap
press Ctrl-C then choose Y for yes to cancel. 

3. Type IBMIGRAT and press enter. 

4. The computer should display a screen asking if you want to Slide or Quit. Choose Slide. 

5. The IBMaster program screen should now appear. Choose “Upload to image file.” Press the space bar o
partition to be imaged and press enter. Enter the name and location of the image file to be created (e.g. 
f:\DATA\WIN95\WIN95.IMG). Then choose Start.

Important:  The IBMIGRAT.EXE utility can be used as a work around for installing BootWorks on an exis
computer that does not have ample free space at the beginning of the drive, BUT DOES HAVE AMPLE 
SPACE AT THE END THE DRIVE. This is accomplished by creating an image of the desired computer f
ing the steps above, installing BootWorks on the computer and then restoring the newly created image b
the computer.

SIDgen
Imaging or cloning Windows NT computers presents a unique problem. Typically Windows NT servers and w
tions are identified to a Domain-based network by a Security ID (SID). Since this identifier must be unique, s
an image of one Windows NT computer with other computers on the network could cause conflicts. To resolv
problem, Altiris provides an NT SID replacement tool called SIDgen. Information on the use and features of S
are contained in the SIDgen User Manual available at the Altiris Web site.

ImageExplorer
Altiris’ ImageExplorer allows users to view and make modifications to image files created by Altiris’ products. 
can view information about partitions and files contained within such an image file, and can extract files from
image, include and exclude files from imaging, search for files, and even replace files within the image. All of
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features can be accessed via standard Windows menus, toolbars buttons, hotkeys, and context menus (right
on an item). For details, see ImageExplorer documentation.

AutoImager
AutoImager is another adaptation of Altiris’ ImageBlaster technology. By creating a self-extracting executable
from either a new or existing image, you can give your clients an instant disaster recovery solution, whether th
the next cube or around the world.

If you’re a manufacturer wanting to provide a simple image re-creation tool for your distributors or an IS cente
ing a self-contained recovery technique to mail a client in outer-anywhere, AutoImager is your answer. With A
ager, you gain substantial versatility in how to distribute “factory fresh” or customized images for individual 
situations. For details, see AutoImager documentation.
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Technical Support
Altiris is dedicated to giving you the best support possible. Please check the Automated FAQ System on our w
before contacting us with your questions. 

Be sure to include a detailed description of your environment, the problem, and any error messages you have
received. We welcome and encourage all feedback and enhancement requests. 

You can contact the Altiris Support staff by phone, fax, mail or e-mail.

Mail
Altiris, Inc.

387 South 520 West

Lindon, Utah 84042

Email 
Quick response E-mail support at support@altiris.com 

Phone 
Call us at (801) 226-8500 (Monday through Friday, 8am to 5pm MDT). Phone support is always free during a 
evaluation period and for at least 90 days following purchase. 

Fax 
Send a Fax to Altiris’ Support by using (801) 226-8506.  

Web
www.altiris.com

Feedback
To submit comments and suggestions about this documentation, send an email to:

support@altiris.com 

Please include complete details of your questions, suggestions and examples.

Thank you for using Altiris products!
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Legal

Disclaimer
Information in this document is subject to change without notice. The software described in this document is 
nished under a license agreement or nondisclosure agreement. The software may be used or copied only in 
dance with the terms of those agreements. No part of this publication may be reproduced, stored in a retrieva
or transmitted in any form or any means electronic or mechanical, including photocopying and recording for a
pose other than the purchaser’s personal use without the express written permission of Altiris, Inc. 

Limitation of Liability
ALTIRIS’ AGGREGATE LIABILITY ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SOFT-
WARE, DOCUMENTATION, OR SERVICES (REGARDLESS OF THE FORM OF ACTION OR CLAIM - E.G.,
BUT NOT LIMITED TO, CONTRACT, WARRANTY, TORT, MALPRACTICE, FRAUD AND/OR OTHERWISE)
IS LIMITED TO THE TOTAL OF ALL PAYMENTS RECEIVED BY ALTIRIS FROM CUSTOMER UNDER 
THIS AGREEMENT. ALTIRIS SHALL NOT IN ANY CASE BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, INDIRECT OR PUNITIVE DAMAGES EVEN IF ALTIRIS HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. ALTIRIS IS NOT RESPONSIBLE FOR LOST PROFITS OR REVENUE
LOSS OF USE OF SOFTWARE OR OTHER PROGRAMS, LOSS OF DATA, COSTS OF RE-CREATING LOS
DATA, THE COST OF ANY SUBSTITUTE EQUIPMENT OR PROGRAM OR CLAIMS BY ANY PARTY 
OTHER THAN CUSTOMER.

Copyrights
Copyright © 1997-1999 Altiris, Inc. All rights reserved. 

Portions of the software described in this document copyright © Novell Corporation. All rights reserved. 

Portions of the software described in this document copyright © Microsoft Corporation. All rights reserved. 

Patents
U.S. PATENT NO.: 5,764,593 was issued for “BootWorks,” a METHOD AND SYSTEM FOR THE INTERCEP
TION AND CONTROL OF THE COMPUTER BOOT PROCESS.

Trademarks
Altiris, RapiDeploy, LabExpert, ImageBlaster Agent, ImageBlaster, ImageBlaster Pro, BootWorks, SIDgen, Bo
Disk Wizard, Image Explorer and RapiDeploy AutoImager are trademarks or registered trademarks of Altiris,
the USA and other countries. 

KeyLabs is a trademark of KeyLabs, Inc.

Novell, NetWare and IntranetWare are trademarks or registered trademarks of Novell, Inc. 

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation. 

Hi/fn is a trademark and LZS is a registered trademark of Hi/fn. 

Other brands and their products are trademarks or registered trademarks of their respective holders.

Altiris, Inc. 

387 South 520 West 

Lindon, UT 84042 

U.S.A. 

801-226-8500
 1998, 1999 Altiris, Inc. page 40 of 40


	Update Information
	Executive Summary
	What LabExpert can do for you
	Overview
	LabExpert Basic Model
	BootWorks
	The Control Console
	ImageBlaster Agent
	Registry Management
	The Remote Control Agents
	Process Builder
	LABCMD and NEXTSTEP



	LabExpert Quick Start Guide
	LabExpert Components
	Before You Proceed
	Install LabExpert
	Create a BootWorks User
	Create BootWorks Diskettes
	Create the Install Diskettes
	Create the Boot Diskette

	Create Batch Files
	Create the Image File
	Install BootWorks
	Test the Installation
	Multicast the Image File
	Upload Registry Files
	Test the Complete Solution


	Install LabExpert
	System Requirements
	Network Server
	LabExpert Control Console (LCC)
	Networked Computers

	Prerequisites
	Overview
	Setup
	Directory Structure
	Licensing Altiris Applications
	License Utility
	Create a user account
	Sample login script


	Control Console
	Tree View vs. List View
	All Computers
	Groups
	Batch Files
	Template Batch Files


	Remote Control Agents
	Console Scripting Tool
	Usage

	Process Builder
	Computer Boot Commands
	Command to Boot Virtual Floppy
	Rebooting Computers
	Executing Commands Remotely
	Optional Settings
	Remote Control Commands
	Help Files
	Communication Protocols


	BootWorks Overview
	BootWorks Options
	BootWorks Installed On Hard Disks
	Automation Partition Drive Assignments
	Automation Partition Sizing

	BootWorks Install
	Phase One
	Phase Two

	Installation Command Line Options
	OS Considerations
	Master Boot Record
	Partition Slot Dependencies
	Windows NT

	Running BootWorks
	Environment variables

	Starting the BootWorks client for the first time

	Disk Imaging
	Registries Management
	95REGMGR and NTREGMGR
	Usage
	95REGMGR [switches]
	NTREGMGR [switches]

	MREGMGR
	Example
	MREGFILE Switches

	REGUP.BAT and REGDWN.BAT

	Power Tools
	Command line options
	UPLOADDB
	COMPID
	IBMIGRATE
	Usage

	SIDgen
	ImageExplorer
	AutoImager


	Technical Support
	Mail
	Email
	Phone
	Fax
	Web
	Feedback

	Legal
	Disclaimer
	Limitation of Liability
	Copyrights
	Patents
	Trademarks


